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TreeSize Professional is a powerful and flexible harddisk space manager for Windows 
98/ME/NT/2000/XP. Find out which folders are the largest on your drives and recover 
megabytes on it. TreeSize Professional shows you the size, allocated and wasted space, the 
number of files, 3D bar and pie charts, the last access date, the file owner, the NTFS 
compression rate and much more information for several folders or drives you choose. It also 
lets you search for old, big and temporary files. The application has an intuitive Explorer-like 
user interface and it is fast and multi threaded. You can print detailed reports or export the 
collected Data to Excel and to an HTML or ASCII file. TreeSize Pro can be started from the 
context menu of every folder or drive.

For every button and menu item in the TreeSize Professional window, a short description is 
displayed in the status bar. If you have further questions, you can contact JAM Software.

    Tips & Annotations

    Options

    Wasted Space

    Charts

    Printing

    File Search

    Registration



Installation
To install TreeSize Professional, execute TreeSizePro-Setup.exe or Tsizepro3-reg.exe on the 
install media and follow the instructions. The Setup program then copies the necessary files to 
your harddisk and creates a new program group in the Start Menu. TreeSize Professional can 
be uninstalled using the Software applet in the Control Panel of Windows. The password 
needed for installing the registered version is printed on the disk label or included in our e-mail.



Quickstart
Please refer to the numbers in the picture when reading the following description.

1. Here the user can select, which drive or path should be scanned. Press the button with the 
arrow on the right to start scanning. TreeSize Pro here remembers the last paths that have 
been used.

2. Here the user can get an overview about the currently scanned drive. This and the other 
toolbars can be turned off in their context menu.

3. The "Chart"-page shows a pie or bar chart of the currently selected directory. Use the 
context to show a toolbar with advanced charting features.



4. The "Details"-page shows detailed information about the subfolders and the files inside the 
currently selected folder.

5. The "Extensions"-page shows the size information grouped by file types, that way you will 
get an overview what file types eat up most of the space. 

6. The "Users"-page shows the size information grouped by user names, this allows you to 
see which users use most of the disk space.

7. The file system tree of the scanned folder or drive gives you an immediate overview about 
the size of each folder.

8. The status bar informs about the allocated and free space of the current drive, the file 
system type, etc.



What's new in V3.0?
Changes in V3.0:
· TreeSize Pro can now show the results for each folder grouped by user or by extension
· TreeSize Pro is now able to save its data to an XML file and to load it again later.
· A saved XML file can be used to compare it against the current version of the file system 

branch. The difference between the two scans will be displayed and makes it easy to see 
which folders have grown.

· Now the columns can be configured separated for the TreeSize Pro window, Excel export, 
HTML Export, Text export and printed reports. Some new columns have been added. The 
columns can be selected and sorted in the Options dialog.

· New columns for: Attributes, Directory Level, File Type
· New toolbar that gives you a quick and easy overview over the currently selected file system 

branch.
· It is now possible to send a text report by e-mail via MAPI
· New command line option /EMAIL for sending reports by e-mail
· New command line option /FILTER that allows you specifying filters
· New command line option /RESTRICTED that switches TreeSize Pro in a "readonly" mode 

that does not allow file system operations etc.
· It is possible to restrict the scan to files which have the archive attribute set. This is for 

example useful to calculate the size that a backup will use.
· The new /TITLE command line options can be used to change the title of the printed or 

exported report. That allows you to supply additional information to the user when using 
TreeSize Pro in an automated environment

· TreeSize Pro now scans folders that have been dropped on its window from the Explorer
· In the context menu is a new menu item "Remove From TreeSize" which removes a folder 

from TreeSize and recalculates the values without deleting it from disk.
· In the Options you may now select that only files created in the past XX days should be 

included in the search. That way you may identify folders that have recently grown much.
· It is now possible to export the selected entries in the details list to the clipboard using the 

context menu.
· The context menu of the file system tree now offers the possibility to copy the data or the file 

list of only the select subbranch to the clipboard.
· If a selected folder is shown in the details view (with "Show Files" option activated), TreeSize 

Pro now recalculates the size of the files in this folder "on the fly".and updates its statistics 
· A context menu lets you show/hide each toolbar
· The values in the status bar now also use the unit that the user has chosen.
· Support for Windows 95 and Excel 95 has been dropped.
· If the [Files] are selected, TreeSize Pro now shows the individual files of that folder in the 

chart.

File Search
· It is now possible to move all checked files of the Obsolete File Search results to a ZIP file
· The File Search now has an exclude list. A file or folder that contains one of the exclude 

patterns will be excluded from the file search
· Files that have been created with the attribute FILE_ATTRIBUTE_TEMPORARY may now be 

included in the temporary file search results
· The temporary file search now can also search for files that are own by an account that is not 

existing any more on the system.
· The temporary file search now can also search for shortcuts and PIF files that have a non 

existing target.



· Each Temporary File Search pattern now has a checkbox in front of it with which it can be 
turned on or off individually

· The /SAVE command line options now also works for file searches and saves the results to a 
textfile

· The size of folders is now shown in the File Search results

Changes in V2.4:

· Great improvement: TreeSize Pro is now able to scan folders under Windows NT4/2000 to 
which the current user doesn't have access to. You just have to be      logged in as 
Administrator or as normal user which has the right to perform backups. In previous version of 
TreeSize Pro you just got an "Access Denied" error message.

· New Option in the Options dialog which lets you choose if TreeSize Pro should follow mount 
points and symbolic links (new features of Windows 2000)

· TreeSize Pro now takes the file based compression of NTFS into account, when calculating 
the allocated space.

· Compressed files and folders may now be shown in a blue color. If only some files in a folder 
are compressed, it will be shown in dark blue.

· In a new column in the details view, the compression rate of NTFS-compressed folders and 
files is shown. This is a very unique feature!

· The Option to see values in KB, MB or a mixed mode has been moved from the option dialog 
to the toolbar.

· The charts can now also be saved to a JPG file. The chart now has a context menu that 
allows copying or saving the chart and showing the chart toolbar.

· Added HTML export. You can either use File|Export|Save as HTML or the new command line 
option HTML. HTML reports are more easy to read than text reports and you don't need to 
have a special application like MS Excel installed. We also added the new command line 
options /HTML.

· You can now open the software applet of the control panel easily from the toolbar of TreeSize 
Professional.

· Additionally to showing folders in bold that are larger than a certain percentage of the scanned 
folder, you can now also enter a fix value in MB, over that all folders will be shown bold. And 
you can apply these settings for printed reports too.

· AutoComplete feature for drive dropdown box similar to the Windows Explorer.
· It is now possible to scan all visible disk shares of a domain or server by entering the 

domain/server name like \\HOSTNAME in the drive dropdown box or by selecting it in the 
'Browse for Folder' dialog.

· charts and details list can now be updated automatically during scanning every few seconds.
· Files that are in use are now excluded from the file search results.
· A new column shows the owner of a file or folder under Windows NT4/2000.
· Errors occurring during scheduled scans are now added to the error log of Windows NT/2000.
· It is now possible to scroll large bar charts using the mouse wheel. Pie charts can be rotated 

using the mouse wheel.
· Replaced the /CHART command line option by /BARCHART and /PIECHART
· Tsizepro.exe has been compressed with UPX.



Frequently Asked Questions
Q: The wasted space shown by TreeSize is extremely high. How can I reduce the wasted 

space?
A: Most likely you are using the FAT file system which usually produces a lot of wasted space 

due to its large cluster size. Please read the chapter "Wasted Space" in the Help file to 
understand what wasted space is and to learn how to reduce it.

Q:Why is the occupied space that Windows shows in the properties dialog of the drive 
larger than the allocated space that TreeSize reports.

A: The Windows Explorer shows the space that is physically allocated on the drive while 
TreeSize shows the space that is occupied by all files under a certain path. Beyond the 
space that is needed for storing the files itself, additional space is used for storing 
management data like the File Allocation Table of the file system or the boot sector. It is not 
possible to free this space with TreeSize or any other tool. This is usually 0.5-2% of the 
occupied space. Another possibility is that you are using Software RAID, like Windows 
NT/2000 offers it, which spreads the data with redundancy over several disks. These disks 
will appear as one logical volume and the failure of a single disk will not cause any data loss. 
But for storing the redundant information, additional space is needed. If a drive letter points to 
a subfolder of a network drive, the allocated space (correctly) reported by TreeSize may also 
be much smaller than the physically allocated space on this drive reported by the Windows 
Explorer, because maybe not the whole drive is accessible through the network.

Q: For some folders TreeSize shows last accessed / changed dates that are far in the 
future. Why?

A: The last access/change date that TreeSize shows for a folder is the latest last access/change 
date of a file inside this folder and its subfolders. Most likely, somewhere in these folders are 
files with a last access/change date far in the future, and so the last change date of the whole 
folder has the same date. You can try to search for these files using the Windows file search. 
These files are often a result of Y2K test or of a client PC with a wrong system date.

Q: Why do all files on my disk have the same last access date which is not far in the 
past?

A: Windows updates the last access date of a file each time when an application is accessing or 
reading a file. Many backup and virus tools access every file on your harddisk regularly 
without restoring the prior last access date.

Q:Why does TreeSize Pro not include my disk into its calculation, which is mapped to a 
directory using the Disk Manager of Windows 2000/XP?

A: Switching the option "Follow mount points and symbolic links" in the Options of TreeSize Pro, 
you can control if TreeSize Pro should follow mount points and symbolic links or should 
exclude them from its calculations.

Q: Scanning a server disk via network is very slow. Is it possible to speed up this 
process?

A: Scanning a drive via network is normally much slower than scanning a local disk, because 
the bandwidth to the network is much lower than to your harddisk. Additionally, server drives 
usually are much bigger and contain more files than local hard disks. But you can use the 
Command Line Options to perform your scans overnight.

Q: I would like to print an entire list of contents of my harddisk. Why does TreeSize Pro 



not support this?
A: A normal Windows 2000 installation itself already has 6000 - 8000 files in the Windows 

directory. Just printing this directory would produce 90 - 130 pages and printing a whole drive 
would produce much more pages. Therefore TreeSize Pro only supports printing the contents 
of the currently selected folder. Additionally you can export a complete list of all files on the 
scanned drive or folder to the clipboard, which allows you further processing of the list like 
inserting it in a database or spreadsheet.

Q: Is it possible to have the program ignore displaying folders in the tree that are less 
than a certain size?

A: In the context menu of the topmost folder, you can choose to remove folders below a certain 
size. To achieve this, press the right mouse button on the topmost icon (or use the "Branch" 
submenu of the "File" menu), select "Expand" and then "Remove Folder <XX MB".

Q:Can I scan network drives and fhidden shares like \\Server\C$ without connecting 
them to a drive letter?

A: Yes, you can use UNC names like \\SERVERNAME\Sharename to access a network drive by 
entering them in the drive combo box of TreeSize Pro. You can also use UNC names on the 
command line.

Q: I would like to save a set of drives and folders that TreeSize Pro scans each time I start 
it. How do I do that?

A: You can simply create a shortcut to Tsizepro.exe on your desktop or start menu and add 
those drives and folders to the command line, separated with a space character. See chapter 
Ownerr more detailed information.

Q:Why does TreeSize Professional not include a duplicate file search?
A: We made several tests with existing duplicate file search tools. The amount of disk space 

that could be recovered was always negligible, because only very few files were "true" 
duplicate (obsolete) files. But the amount of time that was needed to go through the list of 
duplicate files was huge. So we decided not to include a duplicate file search.

Q:Why does TreeSize Pro not support Unicode characters?
A: One reason that we currently do not support Unicode characters is that our development 

environment does not yet support this. The second reason is that a program that uses the 
Unicode API calls of Windows NT and later, will not run any more under Windows 9x. But we 
will surely switch to Unicode in a later version of this software. If TreeSize Pro tries to scan a 
folder name containing Unicode characters, an error message will be displayed and TreeSize 
will continue using the 8+3 DOS name of this folder. These error messages can be turned off 
in the Options dialog of TreeSize Pro.

Q:Why do error messages appear when I am scanning a directory tree that contains Mac 
files?

A: Under MacOS file and folder names may contain characters that are invalid under Windows 
(e.g. /, |, <, >, ?) or that are not part of the normal Windows character set. Normal Windows 
applications cannot access these files or folders, in this case TreeSize uses the 8+3 DOS 
name of the folder. The error messages that are shown can be turned off in the Options 
dialog of TreeSize Pro. 

Q: Is it possible to check several or all files in the File Search window at one time instead 
of checking them individually?



A: You may select several files using a left mouse click while holding the Shift or Ctrl key down. 
You may also press Ctrl+A to select all files in the list. Using "Check" from the context menu 
then checks all currently selected files. Some successive files can also be easily checked by 
pressing the space bar several times. The space bar checks the currently focused file and 
advances to the next file in the list.

Q: On a Novel Netware volume, TreeSize reports compressed files as uncompressed and 
the user names are missing in the Oner columns. Why?

A: Unfortunately the Netware client for Windows does not support information about 
compression and file owners through standard Windows API functions. So developers have 
to integrate special support for Netware in their applications. We will address this issue in a 
later version of TreeSize Professional.

Q:How can I order TreeSize Professional and how will it be delivered?
A: You may order TreeSize Professional online at http://www.jam-software.com/prices.shtml. 

You will find a fax order form there as well. These orders will be processed by our sales 
department or by our partner, the ShareIt! Registration Service. If you choose to download 
the full version, you will receive the address of a (secret) download page for registered users, 
where you can download the full version of this software. If you choose to receive the 
software on disk with a printed manual, shipping costs of 6€ / 10$ will be added to your order. 
You will then receive the software by air-mail within 2-7 days, dependant on where you are 
located.

Q:Although I have purchased the full version of TreeSize Pro, it still shows 
"UNREGISTERED" in the window title. Why?

A: There are 3 possible reasons why "UNREGISTERED" still shows up:
1. You did not download and install the full version from the URL you received after the 

purchase.
2. You have accidentally installed the trial version again. (Have you been asked for a 

password?)
3. You have installed the full version to a different folder than the trial version, which is now 

still on your disk.

Q:Why don't you use activation codes which turn the trial version into a full version?
A: We do not work with activation codes, because you can find them very easily in the internet. 

We are working with a separate trial and full version. After purchasing, our customers receive 
the download address for the full version and a password which is needed for installation. 
You should keep both in a safe place.



Tips & Annotations
· Especially scans of network drives may take a long time. You may perform these scans 

overnight using the command line options of TreeSize Pro and save the results to an XML file, 
which can be loaded to TreeSize Pro again later.

· The last access date is the day when a file was used the last time, for example when a 
program was executed, a DLL was loaded or a bitmap was shown the last time. So if a file has 
not been accessed for a long time, it may probably not needed on your system. This is great 
to remove unused files from your Windows and System directory.

· With a user defined cluster size, you can look how the values for occupied and wasted space 
would look like with a different cluster size on your harddisk. A rescan of the current folder(s) 
is necessary when you change the user defined cluster size.

· You can use the CD-ROM cluster size to determine, how much space a directory tree would 
occupy on a CD-ROM. Please keep in mind that some space on a CD-R will be needed for 
the directory information.

· The 'filter' and 'user defined cluster size' settings are not saved to the registry in order to avoid 
wrong values when using TreeSize Professional the next time

· In the Recycled Folders you will not see the same file names like in the Explorer. This is 
necessary to get the size and the last access date of these files.

· Select 'Full Expand' from the context menu of a folder or drive before printing a report in order 
to get a report for the entire file system tree.

· You can scan all shares in a domain by entering the domain name in the drive combo box of 
TreeSize Pro.

· Use the 'File Search' to find large or obsolete files on your hard drives.



Options Dialog
This dialog box allows you to change the view and scan options of TreeSize Professional. On 
the View tab, you can specify the following options:

Different Colors For Compressed Files and Folders          If this option is turned on, compressed 
files on an NTFS volume are shown in a blue color. Folders that are 
partially compressed will have a dark blue color, files and folders that are 
entirely compressed will show up in a light blue color. For more information 
on file based compression, see Notes on NTFS.

Show Files When this option is selected, TreeSize will display the files in a folder 
summarized in one object in tree. Also all files of a folder will appear in the 
Details View.

Show Chart toolbar Use this option to display an additional toolbar for the Charts.

Automatically Update Right Pane During Scanning          If this option is turned on, TreeSize Pro 
will update the right pane of the window from time to time. This allows you 
for example to watch the bars of a chart growing while scanning large 
drives. Use the dragbar to set the interval of the updates.

Decimals Choose the number of decimals that should be used when TreeSize 
displays or prints values.

Number of Folders in the Recently Used list          Adjust the number of recently scanned folders 
that TreeSize Professional 3 should memorize for quick access in the File 
menu or the dropdown box in the toolbar.

Bold Factor If the size of folder is greater than the set percentage or absolute value of 
the complete size of the scanned folder, the folders label will be shown 
bold. This allows you to find quickly the largest folders. If you don't want 
bold folder labels, choose 100%. You can apply these settings also for 
printed reports as well by using the checkbox below.

The Scan tab holds the following scan options:

Follow Mount Points and Symbolic Links          This option is relevant for NTFS drives only. You 
can decide if TreeSize should follow symbolic links and mount points (see 
Notes on NTFS for additional information).

Show Error Messages      Here you can decide if TreeSize Professional should show error 
messages during scanning. If you for example scan a network drive on a 
Windows NT server and don't have read access to all folders, Windows will 
pop up an error message for every unreadable folder. If you don't want the 
scanning process interrupted by these message boxes, deselect this 
checkbox.

Group by user when Scanning        If this checkbox is activated, TreeSize Professional 3 will 
additionally group the data of all folders by user. The results can be viewed 
on the "Users" tab of the main window. Since it is necessary to obtain the 



owner of each file, this option will slow down the scanning process if 
activated.

Group by extension when Scanning        If this checkbox is activated, TreeSize Professional 3 will 
additionally group the data of all folders by the file extensions. The results 
can be viewed on the "Extensions" tab of the main window. 

User Defined Cluster Size     Use this option to look, how the values for allocated and wasted 
space would look like with a different cluster size or filesystem. Changing 
this option will make a rescan necessary. This options will not be saved 
when you exit TreeSize Professional in order to avoid wrong results when 
using TreeSize the next time.

The Include/Exclude tab allows you to filter the scanned files and folders:

File Types If you want to have information about certain file types only, you can specify 
a filter here. You can use multiple filters separated with blanks. So If you for 
example want to see how much space    your executable files and their 
libraries occupy, use the filter "*.exe *.dll" here. If you want to include all 
files use "*". Changing this option will make a rescan necessary. This 
options will not be saved when you exit TreeSize Professional in order to 
avoid wrong results when using TreeSize the next time.

Include only files created in the past XX days          This option is quite self-explanatory and can 
be useful to calculate the size of backups or to identify "heavy growing" 
folders.

Include only Files with Archive Bit Set        This option is useful if you are interested in the size of 
a backup, that will be performed based on the Windows Archive Bit.

Excludes If you want to exclude certain files or folders from scanning, add matching 
patterns here. A pattern may look like "Windows" or "*.tmp". Files or folders 
matching one of the specified patterns will be ignored during a scan.

On the Columns tab allows you may choose the columns that should be visible. You may 
choose the columns separately for each "output media" (details view, Excel export, printed 
report, text file, etc.) by first selecting the appropriate entry in the dropdown box on the top.



Wasted Space
The wasted space is the amount of space in clusters on your harddisk, that are not entirely 
filled. Keep the following formula in mind: size + wasted space = allocated space. Windows 9x 
with its file system FAT/FAT32 may have very large cluster sizes, dependent on the partition 
size:

FAT FAT32
Partition Size            Cluster Size Partition Size Cluster Size
128 - 256 MB    4 KB 1 - 8 GB 4 KB
257 - 512 MB      8 KB 8 - 16 GB 8 KB
513 - 1024 MB    16 KB 16 - 32 GB 16 KB
1025 - 2048 MB 32 KB >32 GB 32 KB

If you for example have a single FAT32 partition on a 32GB harddisk, you have a cluster size of 
32KB on it. If you store 10 files of 1 KB on this partition, this would use 10*32KB=320KB of your 
precious harddisk space, and 320KB-10KB=310KB would be wasted. Especially a huge number 
of small files significantly increase the amount of wasted space on FAT partitions.

To reduce the wasted space, there are the following possibilities: 

· Make smaller partitions, try to avoid partitions larger than 16GB on a FAT32 drive. Of course 
smaller partitions will increase the number of drive letters.

· Windows NT/2000/XP provide the possibility to format your harddisk with the NTFS file 
system. It usually operates with 512 - 4096 Byte clusters and has the best storage efficiency 
of all Windows file systems. NTFS partitions cannot be accessed from Windows 9x or DOS 
without use of 3rd party software. In addition, NTFS is able to compress selected directory 
branches.



Printing
TreeSize Professional 3 TreeSize Professional has flexible printing functions:

You can print a detailed report by selecting 'Print Report...' from the File menu or by pressing 
the print button in the toolbar. The report will show the directory structure of the current folder, 
including directory lines, and the information you have chosen in the Options. Only those folders 
will be printed in the report, which are visible in the TreeSize Professional window. This way you 
can choose the folders that will be included in the printed report. To get a complete report that 
includes all folders and subfolders, select 'Full Expand' from the context menu of the topmost 
folder.

If the 'Details View' is active in the right pane of the TreeSize Professional 3 main window, you 
can print the contents of the folder which is currently selected by using 'Print Folder 
Contents...' from the 'File' menu. You will see all files and subfolders in the printout, including the 
icons, the size, allocated and wasted space and the number of objects. If you want a listing of all 
files in the scanned folder or drive, you can copy a list of all files to the clipboard and paste it 
into your favorite spreadsheet or word processor by selecting 'Export List of Files' from the 'File' 
menu. If the 'Chart View' is active in the right pane of the TreeSize Professional window, you 
can print the current chart by selecting 'Print Chart' from the 'File' menu.

You can use the Page Setup Dialog to adjust the margins for printing. Use the Print Setup 
Dialog to choose a printer. Both dialogs can be accessed from the 'File' menu.



Charts
TreeSize Professional can visualize folder sizes as pie or bar charts. A chart always shows the 
size of the subfolders of the currently selected folder. A pie chart shows the size, allocated 
space, wasted space etc. dependant on what kind of view type the user selected in the toolbar. 
The bar chart shows the size, allocated and wasted space together in one chart, because:    size 
+ wasted space = allocated space. If a bar chart doesn't fit in the window, a scrollbar is 
displayed on the right side, which allows scrolling in the chart. 

In the pie chart, small folders may be summarized in a slice named 'Other'. If a root of a drive is 
displayed in a pie chart and you have switched to the 'Allocated Space' mode, the free space of 
this drive will also be displayed as one slice of the pie.

Clicking on a slice or bar shows detailed information about the corresponding folder, double 
clicking will move into the selected folder. Checking 'Chart Toolbar' in the Options dialog or in 
the context menu of the chart will display an additional chart toolbar, which allows you to 
manipulate the charts in several ways, for example zooming, turning on or off the grid lines, 
switching between 2D and 3D mode, change colors, etc. Using this toolbar, you can also copy 
the current chart to the clipboard or save it as a file. 

Choose 'Print Chart' from the 'File' menu to print a chart. A chart will be printed exactly as you 
see it on the screen.



Command Line Options
TreeSize Professional accepts command line options which allow you to do scheduled scans or 
to have the results of a scan on your monitor the next morning.

Tsizepro.exe [/(BAR|PIE)CHART filename] [/DATE] [/EMAIL] [/EXCEL filename] [/EXPAND 
[level|xxMB]] [/FILTER pattern1;pattern2;...] [/HTML filename]  [/NOGUI] [/PRINT] 
[/SAVE filename] [/SEARCH[:Start|:Internet]] [/XML]  directories

/BARCHART    Saves the bar chart of the scanned directory to a bitmap or JPEG file, the file 
type depends on the extension of the specified file name. This example creates a 
JPEG images of the bar chart for drive C:

tsizepro /BARCHART C:\Documents\c.jpg C:\

/DATE This switch will add the current date to all file names occurring after it on the 
command line. This is useful if you want to do scans regularly every night or every 
weekend. If you want the date included in all filenames, then /DATE should be 
your first command line option. The following example will scan the network path \
\host\share and save the result to a file like C:\scans\name_03-12-
20_1550.xls:

tsizepro /DATE /EXCEL C:\scans\name.xls \\host\share

/EMAIL Sends the collected data to the given email address using MAPI. Your e-mail 
application must be configured properly for MAPI. Example:

tsizepro /EMAIL sysadmin@company.com \\SERVER\C$

/EXCEL Exports the collected data to Excel and saves it under the given file name. If the 
file name already exists, the file will be opened and a new sheet will be added. 
TreeSize Professional will terminate itself after saving. Example:

tsizepro /EXCEL C:\Documents\c.xls C:\

/EXPAND This option lets you specify, how many levels in the directory tree will be expanded 
after scanning. If you don't specify a number, all folders will be expanded. Instead 
of a directory level you can also indicate an amount in MB. In this case all folders 
larger then the given amount will be expanded. The unit 'MB' must follow the 
number without a blank. The following example will scan the folder H:\user, expand 
all folders larger than 10MB and save the result to the Excel file C:
\Results\Allusers.xls:

tsizepro /EXCEL C:\Results\Allusers.xls /EXPAND 10MB H:\user 

/FILTER Allows to set a file filter, so that only files with certain extensions, e.g. .MP3 
or .DOC, will be counted. Multiple patterns may be passed, you can use spaces, 
commas or semicolons as separator between the patterns. The following example 
will search for AVI and MP3 files in the users directory on the server:

tsizepro /EXCEL C:\Results\MediaUsers.xls /FILTER "*.mp3;*.avi" \
\Server\Users 

/HTML Saves the collected data to a HTML file, which can be viewed with any HTML-
browser later.    If you also have a /PIECHART or /BARCHART parameter in your 



command line, the image will be included in the HTML file. The following example 
will generate an HTML report for the drive C: and saves it to D:\html:

tsizepro /DATE /HTML d:\html\treesize.html /PIECHART d:\html\treesize.jpg 
C:\

If you like to scan and export multiple drives or folders, we recommend that you 
either use one call for each drive or folder, or that you use the command line 
option like in the following example

tsizepro /HTML d:\html\drive_c.html /PIECHART d:\html\drive_c.jpg C:\ 
/HTML d:\html\drive_d.html /PIECHART d:\html\drive_d.jpg D:\

/NOGUI No window will be shown and the application will not appear in the task bar. Useful 
for background scans. Caution: Use this switch only if you have tested the rest of 
the command line options, because TreeSize Professional cannot display error 
messages in this mode. However, it tries to log errors in the event log of Windows.

/PIECHART    Saves the pie chart of the scanned directory to a bitmap or JPEG file. The 
following example will scan the drives C:\ and D:\ and produce a chart for each 
one:

tsizepro /PIECHART C:\Temp\c.jpg C:\ /PIECHART C:\Temp\d.jpg D:\

/PRINT Prints a report for the scanned folder to the default printer. TreeSize Professional 
will be terminated after printing. Usage example:

tsizepro /PRINT C:\ D:\

/PRINT1 Prints only the first page of a report for the scanned folder to the default printer. 
TreeSize Professional will be terminated after printing. Usage example:

tsizepro /PRINT1 \\SERVER\USERS

/RESTRICTED      Starts TreeSize in a "readonly" mode, in which the user does not have access 
to Explorer context menu, may not rename or delete files or folders and the 
buttons for the Software applet and to connect a network drive are not available in 
the tool bar.

/SAVE Saves the results to a text file after scanning is finished. TreeSize Professional will 
terminate itself after saving. Example:

tsizepro /SAVE C:\Results\c.txt C:\

/SEARCH Opens the search window of TreeSize Professional. If ':Start' is added to this 
command line option, the search is started immediately with the settings used the 
last time. If TreeSize finds ':Internet' added to this command line option, it will 
start searching for temporary internet files and delete them. The drives activated 
during the last regular scan will be scanned, a special set of drives and paths can 
be specified on the command line (separated with blanks). Usage example:

tsizepro /SEARCH:Internet



/XML Saves the results to an XML file that can be loaded with TreeSize Pro later again 
or can be used for comparisons.

 

Scheduled Start
If you are using Windows 98/ME or Windows NT4+ with Internet Explorer 5+ installed, you 
can use the 'Scheduled Tasks' folder to run TreeSize Professional daily at a certain time. Just 
add a new daily task and choose TreeSize Professional as program to execute. Before finishing, 
choose to change additional properties of this task and add the command line options you want 
after tsizepro.exe.

If you are using Windows NT4 or later, you can also use the at command to perform scheduled 
scans. If you for example want to scan the drives C: and E: next night at 03:00 a.m. and save 
the results to an Excel file, you must enter the following on the NT command line:

at 03:00 "C:\Program Files\JAM Software\TreeSize Professional 
2.3\tsizepro.exe" /EXCEL c:\temp\tsp.xls /EXPAND 2 c:\ e:\

If you want to see the results of the file search on your screen when you come in your office in 
the morning, you should enter something like:

at 06:00 /INTERACTIVE "C:\Program Files\JAM Software\TreeSize Professional 
2.3\tsizepro.exe" /SEARCH:Start

Read more about the at command in the Windows NT help. Error messages occurring during 
scheduled scans are listed in the Event Log of Windows NT/2000. 

Windows Scripting Host
If you intend to use the Windows Scripting Host (WSH), you command to start TreeSize 
Professional 3 will look like:

Set Shell = CreateObject("WScript.Shell") 
Shell.Run """C:\Program Files\TreeSize Professional\tsizepro.exe"" /XML c:
\temp\drive_c.xml c:\" 



Notes on NTFS
The file system NTFS, which can be used with the operating system Windows NT or later. It 
offers some special features which also have consequences for TreeSize Professional 3. In the 
following we will describe some of these features and their impacts on this software.

Access Control Lists
A user under Windows NT/2000 can restrict the way other users can access his files and 
folders, he can grant or deny other users or groups certain rights like reading, writing, executing 
or deleting files. That way a user can even deny the Administrator to access his files and 
folders. If an Administrator tries to access a folder in the Explorer, to which the owner denied 
any other users read access, an "Access Denied" error message will be displayed. However, 
since V2.4 TreeSize Professional is able to scan such folders, if you are logged in as 
Administrator or as a user that has the right to perform backups (This option can be changed at 
Control Panel / Administrative Tools / Local Security Policy under Windows 2000 and with the 
user editor of Windows NT).

File Based Compression
NTFS supports compression on an individual file basis. Files that are compressed on an NTFS 
volume can be read and written without first being decompressed by another program. 
Decompression happens automatically during the read of the file. The file is compressed again 
when it is closed or explicitly saved. 

The space occupied by a compressed file is usually much smaller than its normal size. As a 
consequence, for folders that are partially or completely compressed, the allocated space 
reported by TreeSize may be smaller than the size reported for this folder. TreeSize Pro is able 
to show the compression ratio in an extra column in the details view. Additionally it can show 
compressed files and folders in a different color, these features can be turned on in the Options 
dialog.

The NTFS version that comes with Windows 2000 supports an additional concept, that is similar 
to compressed files: sparse files. Files which are large but only partially used are called sparse 
files. Because the operating system does not allocate disk space for the unused parts of a 
sparse file, it occupies less disk space than its actual size is. TreeSize Professional 3 treats 
sparse files like compressed files and also calculates the compression ratio for them.

Reparse Points: Volume Mount Points and Symbolic Links
Since Windows 2000 NTFS supports volume mount points and symbolic links. A volume mount 
point is an existing path where you "mount" another volume. Given this, users and applications 
can refer to the mounted volume by that path. It allows you to unify into one logical file system 
disparate file systems. symbolic links work similar: If you for example have an empty folder C:
\Documents\Images, you can create a symbolic link to E:\Pics in it. Applications will then see the 
content of E:\Pics in C:\Documents\Images.

If you have the Option "Follow Mount Points and Symbolic Links" turned on, TreeSize will 
include the contents of these folders when scanning. Since they are not physically stored on the 
drive you are scanning, this may produce irritating results.



A final note: If you are scanning an NTFS volume via network, TreeSize Professional is only 
able to handle file based compression and reparse points correct, if you are scanning on a 
Windows NT/2000 client. The API of Windows 9x cannot handle these features, so reparse 
points and compressed files will appear as normal folders and files.



File Menu
The File Menu allows you to select folders for scanning, remove folders from the TreeSize 
Window and to export or print the collected data.

Select Directory Shows a dialog which lets you choose a folder for scanning. You can also 
enter a local or network path directly into the drive combo box in the 
toolbar.

File Search Shows the File Search window.

Branch Shows a submenu which is exactly the same as the context menu of the 
root folder.

Update All Rescans all folders which are currently listed in the TreeSize Professional 
window. You can update an individual folder through the context menu of 
this folder.

Load XML Report Opens an XML report that has been saved by TreeSize Pro earlier. That 
way you can view earlier results without performing a whole scan again.

Save XML Report Save the information of the current file system branch to an XML file. This 
file can be loaded to TreeSize Professional 3 again at a later time or can be 
used to perform a compare at a later time.

Compare With XML Report      Loads a saved XML report and compares it to the current one by 
"subtracting" the old size information from the current one. That way, folder 
unchanged in size will show up with a size of 0 after the comparison, folder 
that have grown will have values greater than 0 and will be displayed in red 
color. Folders that became smaller compared to the loaded report will have 
negative values an will be displayed in green color.

Set Title Allows you to set a title for the currently active branch, which will be used 
when the folder data is printed or exported. The default title includes the 
path of the scanned folder and the volume name of the drive where the 
folder resides on.

Page Setup Shows the Page setup dialog where you can specify the margins for 
printing, paper size etc.

Print Report Prints a detailed report of the current folder. See Printing.

Print Chart Prints the currently visible Chart.

Print Folder Contents Prints a list of all objects in current folder, including the icons, size, date, 
etc.

Printer Setup                         Shows the print setup dialog.

You can find a list of the recently scanned folders at the bottom of the file menu.



Export submenu
The Export submenu of the File menu allows you to export the collected in data in different 
ways. You may customize the kind of data (columns) that will be exported on the columns tab of 
the Options dialog. For all ways of exporting applies, that only those folders will be exported, 
that are currently visible (expanded) on the left pane of the main window. That way you may 
customize the level of folders that will be exported manually or by using the context menu.

Save Data As Save the collected data to a tab separated text file.

Save as HTML Allows you to save a report as HTML file, which can be viewed with any 
HTML browser later. HTML files are more easy to read than text files and 
don't require a special application like MS Excel.

Export Data to Excel    Exports the collected data to MS Excel.

Copy to Clipboard Copies the data of the current file system branch to the clipboard in text 
format.

Send by Email Sends the current data as an text email via MAPI.

Include Header Toggles the header in the exported files on or off. If you want to process the 
exported data with other applications, it may be useful to turn the header 
off.

Use Plain Numbers        Activating this option will save the results not in the format "10.2 MB" but 
will save the size information as the number of bytes in plain (e.g. 
10695475). That may make postprocessing of the data easier.

Copy List of Files Copies a list of all files in the current folder (and its subfolders) to the 
clipboard. You can paste this list to your favorite spreadsheet or word 
processor.



View Menu
You can choose different types of values for displaying in the tree on the left side:

Size In this mode the size of the files in a folder including all subfolders will be 
shown.

Allocated Space This will show the amount of space that is allocated on disk for this folder, 
again including all subfolders.

Percent Shows how many percent of the parent folder's size each folder occupies.

Wasted Space Shows the amount of space that is wasted by the filesystem for the storage of 
all files in this folder, including all subfolders.

CD-ROM Cluster Size     This mode will show how much space a folder would occupy on a CD-
ROM.

Use the next menu items to switch between different view modes for the right pane of the 
TreeSize Professional window:

Bar Chart Shows a bar chart on the right side of the window. Each bar shows the size 
and the wasted space for each folder, which together is the space allocated for 
this folder.

Pie Chart Shows a pie chart on the right side of the window. The values displayed in the 
pie chart depend on the currently selected view mode (Size, Allocated Space, 
Wasted Space etc.)

Detailed List Shows a list with all objects in the current folder. For each object, you can see 
the size, the allocated and wasted space, the number of files, the last access 
and change date and the percent of the parent folder in. 

You can change the way TreeSize displays the sizes using these menu items or the 
corresponding toolbar buttons. The number of decimals can be changed in the Options dialog.

Values as KB All size values will be shown in KB.

Values as MB All size values will be shown in MB.

Values as GB All size values will be shown in GB.

Some further commands in the View menu:

Add/Remove Software        Opens the 'Add/Remove Software' applet of the control panel.

File Search Shows the 'File Search' Window, which allows to search for old, big files and 
temporary files.



Options Shows the Options dialog.



Sorting
Sort by size The largest folders will be displayed first.

Sort by name The folders will be sorted alphabetically.

No Sorting No Sorting is done. This can be useful when scanning large folders or 
network drives, because folders don't permanently change their position.



Context Menu
When you right click on a folder or file, TreeSize will display the explorer context menu. 
Additionally you will find the following menu items in the TreeSize submenu

Full Expand Expands the selected folder and recursively all its subfolders

Full Collapse Collapses the selected folder and recursively hides the subfolders

Update Branch Updates only this part of the tree, which is usually faster than updating the 
whole directory.

The topmost item of each scanned folder has a different context menu, which looks like this:

To Level x Selecting this menu item will show the first x levels of the current folder.

Expand Folder over This menu item allows you to expand only those folders in the tree, 
which are larger than a certain size.

Remove Folder <xxxMB Selecting this menu item will remove all folders which are smaller than 
a certain size from the directory tree.

Set Size Allows you to specify the folder size for the above two operations.

Remove from TreeSize Remove this folder from the TreeSize Professional window.

Update Rescan this folder and update the information.



The File Search Window
The 'File Search' window allows you to search for big, old and temporary files. You will find the 
following tabs on the top of the window:

Biggest Files This page allows to search for the biggest files on your harddisk. You can 
specify a minimum size in kilobytes or megabytes. All files, which are larger 
than this value, will be shown in the list.

Oldest Files This page allows you to search for files, that have not been changed or 
accessed since a certain date. You can limit the search to entire folders, in this 
case only folders will be listed in which all files match the search criteria. This 
allows you to identify branches of the file system that are not in use any more.

Temporary Files  This page allows you to search for temporary files. Use the "Configure" Button 
to customize the settings of the Temporary File Search.

Internet Files This page allows you to search for temporary internet files, like the files in the 
cache of the browsers Netscape Navigator and Internet Explorer. On FAT 
drives, these files produce a lot of wasted space, because most of them are 
very small. The search for temporary internet files can be automated with the 
command line option /SEARCH:Internet.

Options Here you can choose which drives and which of the above search types will be 
included in the search. You can add additional paths or UNC paths to the list 
by pressing the button below the list. All checked drives will be included in the 
search.

You will find the following buttons on the right side of the window:

Start This button will start the search. You can now either close the window or you 
can look at the partial search results by selecting one of the tabs. You will hear 
a beep when the search is finished.

Stop Allows you to stop the search.

Hide Window This button will close the search window, but the search will continue. So you 
can look at the results later. You will see an animation below this button, as 
long as the file search is running.

Save Results This button allows you to save the search result of the currently active search 
type in a tab separated text file (CSV file).

Move Checked This button allows you to move all files in the lists, which are checked left of 
their file name, to the recycle bin or to a position in the file system that you can 
specify. If you choose a file system location, all files will be moved there under 
preservation of the file system structure. You may also move the checked files 
to ZIP file. TIP: You can easily check a group of files by keeping pressed the 
space bar or by selecting multiple files with the Shift or Ctrl key and then use 
the context menu.



Temporary File Search - Configuration
Patterns
The main part of the Temporary File Search is based on typical filename patterns. You may 
customize these patterns using the "Customize" button on the top of the Temporary File Search. 
You may change or delete existing patterns as well as add new patterns. Using the checkboxes 
on the left, you can eactivate certain patterns without deleting them.

Include files with temporary attribute
Applications that create a temporary file may inform the operating system with a special flag 
about this fact. With this checkbox activated, TreeSize Professional 3 will include such files in 
the search results.

Include files that do not belong to a valid account
If a Windows account is deleted, files belonging to this account are not deleted automatically 
and may keep occupying space on the hard disks. With this checkbox activated, TreeSize 
Professional 3 will include such files in the search results. Since it is necessary to get the owner 
of each file on the searched disks, activating this option will slow down the scanning process.

Include Links without a valid target path
With this checkbox activated, TreeSize Professional 3 will check for .LNK and .PIF files, if the 
destination path exists. If this is not the case, such a file will be included in the search results.



TreeSize Professional - Registration
Thank you for your interest in TreeSize Professional. There are three different ways for ordering:

1. Secure Online Purchasing is possible from the TreeSize Professional Web Page. You will find a fax 
order form there as well.

2. European companies can be invoiced. Just send or fax your order to the address below. A price list for 
multi user licenses is available on our web site. Please include your VAT ID number in the EU!

JAM Software E-mail : sales@jam-software.com
Joachim Marder WWW : www.jam-software.com
Bruchhausenstr. 1 Fax : ++49-700-70707059
54290 Trier
Germany

After registering, you will receive the address of the (secret) download page for registered users, where 
you can download the full version of TreeSize Professional. Therefore it is important, that your e-mail 
address is correct and written in clear letters. Registered users will get support via e-mail and future 
updates within the same major version number are free. If you want to receive the software on 3.5" 
diskette, please add 10$ / 6 EUR for shipping.



Copyright & Contact
Copyright ©1997-2003 by:

JAM Software
Joachim Marder
Bruchhausenstr. 1
54290 Trier
Germany

Fax: +49-700-70707059

E-mail: treesize@jam-software.com

WWW: http://www.jam-software.com



Enter topic text here.



Choose this option if compressed files and folders on NTFS volumes should appear in a blue color. Folders, that are 
only partially compressed, will appear in dark blue.



When this option is selected, TreeSize will display the files of a folder summarized in one object in tree. Also all files 
of a folder will appear in the list on the right side of the window.



Activates/Deactivates an additional toolbar for the charts.



In the file menu and in the drive combo box, you find a list of the recently scanned folders and drives. Here you can 
adjust the maximum number of entries in this list.



Number of decimals which will be used for displaying or printing values.



Choose the interval for how often the right pane of the window should be updated.



If this option is turned on, TreeSize Pro will update the right pane of the window from time to time.



Turn this option on to apply the settings for bold folder names for printed reports.



If the size of folder is larger than the given percentage of the complete size of the scanned folder, or is larger than the 
given size in Megabytes, the label will be displayed bold. If you don't want bold folder labels, specify 100%.



Enter topic text here.



Choose if mount points and symbolic links should be followed or not. Mount points and symbolic links have been 
introduced in Windows 2000, they can be used to link drives or folders into other file systems. Since these are not 
really part of the file system they have been linked in, they may lead to wrong results for the size of a folder or drive. 
See help file for additional information.



When when this option is turned on, TreeSize Professional shows error messages during scanning (e.g. 
unaccessable folders)



Check this option, if you would like to see the results grouped by username on a sheet    on the right side of the 
window. Turning this option on will slow down the scanning process.



Check this option, if you would like to see the results grouped by extension on a sheet    on the right side of the 
window.



Use this option to look, what the values for allocated and wasted space would look like with a different cluster size or 
file system.



Enter topic text here.



If you want to have information about certain file types only, you can specify a filter here. You can use multiple filters 
separated with blanks. So If you for example want to see how much space    your executable files and their libraries 
occupy, use the filter "*.exe *.dll" here. If you want to include all files use "*".



Use this option to include only files in the scan, that have been changed within a certain amount of days.



When this option is enabled, only files with the Archive bit set will be included in the scan. This can be useful if you 
perform your backup on basis of the Archive bit and you want to know how large you backup will be.



If you want to exclude certain files or folders from scanning, add matching patterns here. A Pattern may look like 
'Windows' or '*.tmp'. Files or folders matching one of the specified patterns will be ignored during a scan.



Enter topic text here.



Here you can select which columns will be visible in the view that is selected in the dropdown box above.




